
Tronisoft Limited 
Email: sales@tronisoft.com 
Web: www.tronisoft.com 

 
 
 
   

  
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 

 
 

 
 
 

 
 
 
 

 

SSiimmpplleeTTeerr mm  SSttaannddaarr dd  ––  UUsseerr   GGuuiiddee  
SSeerriiaall  PPoorrtt  DDaattaa  VViieewweerr  //  TTeerrmmiinnaall  EEmmuullaattoorr  
 

Information furnished is believed to be accurate and reliable. However, the publisher and the author assume no 
responsibility, consequential or otherwise for errors or omissions or use of such information. 

Email support@tronisoft.com with suggestions or to report document inaccuracies, omissions and errors. 
 

Specifications mentioned in this publication are subject to change without notice. This publication supersedes and 
replaces all information previously supplied. 

  
© Copyright 2012 Tronisoft Limited - Printed in England, United Kingdom - All Rights Reserved. 

http://www.tronisoft.com 

P/N: MN-102 
Document version: 2.01 
Date: June 2012 

Advanced Data Capture and Control Systems 



 
 

  
SSiimmpplleeTTeerrmm  SSttaannddaarrdd  ((SSEE))  ––  UUsseerr  GGuuiiddee  

 
 

SimpleTerm Manual v2.01.doc, © Copyright 2012 Tronisoft Limited  - Printed in England, UK - All Rights Reserved. 1 

1 COPYRIGHT NOTICE, ACKNOWLEDGEMENTS................. ................................................2 

1.1 TRADEMARKS .....................................................................................................................2 
1.2 DISCLAIMER .......................................................................................................................2 

2 INTRODUCTION.....................................................................................................................3 

2.1 FEATURES LIST ..................................................................................................................3 
2.2 SYSTEM REQUIREMENTS ....................................................................................................3 
2.3 USER INTERFACE ...............................................................................................................4 

3 FEATURES AND USAGE ................................. .....................................................................5 

3.1 DATA FORMATTING AND COLOUR CODE ..............................................................................5 
3.2 COM PORT INITIALISATION AND CONNECTION.......................................................................6 
3.3 DATA TRANSMISSION FROM FILE / CAPTURE TO FILE .............................................................6 
3.4 CONTROL SIGNAL PANEL ....................................................................................................7 
3.5 STRING ENTRY PANE..........................................................................................................8 
3.6 FIND ..................................................................................................................................8 
3.7 DATA EXPORTING AND PRINTING.........................................................................................9 
3.8 NEW SESSION / CLEAR SCREEN..........................................................................................9 
3.9 ASCII TABLE ......................................................................................................................9 
3.10 SETTINGS WINDOW.......................................................................................................10 
3.11 IMPORT AND EXPORT SIMPLETERM PROFILES ................................................................12 
3.12 STATUS BAR AND BYTE SELECTION INFORMATION..........................................................12 
3.13 USER NOTES ................................................................................................................13 
3.14 NOTATION CONVERTER.................................................................................................16 

4 REFERENCE: MENU, TOOLBAR AND KEYBOARD SHORTCUTS .... .............................16 

4.1 FILE MENU .......................................................................................................................16 
4.2 EDIT MENU ......................................................................................................................17 
4.3 VIEW MENU......................................................................................................................17 
4.4 SETTINGS ........................................................................................................................18 
4.5 COMMS ............................................................................................................................18 
4.6 TRANSFER .......................................................................................................................18 
4.7 HELP ...............................................................................................................................19 
4.8 TOOLBAR .........................................................................................................................19 

APPENDIX A – ASCII CHART ........................... .........................................................................20 

APPENDIX B – RADIX CONVERSION CHARTS ............... ........................................................21 

APPENDIX C – PINOUT AND SIGNALS FOR THE PC RS232 CO NNECTOR.........................22 

APPENDIX D – SIMPLETERM HALF DUPLEX MONITORING CABL E....................................23 

 



 
 

  
SSiimmpplleeTTeerrmm  SSttaannddaarrdd  ((SSEE))  ––  UUsseerr  GGuuiiddee  

 
 

SimpleTerm Manual v2.01.doc, © Copyright 2012 Tronisoft Limited  - Printed in England, UK - All Rights Reserved. 2 

1 Copyright Notice, Acknowledgements 

No parts of this work may be reproduced in any form or by any means - graphic, electronic, or 
mechanical, including photocopying, recording, taping, or information storage and retrieval 
systems without the written permission of the publisher and author. All rights reserved. 

1.1 Trademarks 

Products that are referred to in this document may be either trademarks and/or registered 
trademarks of the respective owners. The publisher and the author make no claim to these 
trademarks. 

1.2 Disclaimer 

Information furnished is believed to be accurate and reliable. However, the publisher and the 
author assume no responsibility, consequential or otherwise, for errors or omissions or use of 
such information contained in this document or from the use of programs and source code that 
may accompany it. In no event shall the publisher and the author be liable for any loss of profit 
or any other commercial damage caused or alleged to have been caused directly or indirectly by 
this document. 
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2 Introduction 

SimpleTerm is an advanced serial port communication tools. It will allow you to view and send 
(all 256) ASCII/Extended-ASCII (non-printable) data in an easy to read colour coded sequence. 
It is a high performance 32-bit application designed to run on almost all PCs running Microsoft® 
Windows 9x, 2000 and XP. 
 
SimpleTerm is a mature, stable product used by professional technicians, engineers and 
software developers as a development aid and debugging tool for RS232/serial port related 
projects. 
 
SimpleTerm will work with the serial/COM ports provided by your operating system. Physically, 
these ports will be male RS232 SUB D9 interfaces in most cases. However, it is also possible to 
use SimpleTerm for other communication standards such as RS485 and RS422, which have a 
different electrical design to RS232 but follow the RS232 communication mechanism. Also 
supported are “Virtual COM” ports presented by e.g. USB-Serial adaptors & Bluetooth™ Serial 
Port Profile devices. The quality of support is limited only by the quality / compliance of the 
device drivers in emulating a normal COM port. This manual will only refer to RS232 based 
connections as this is the basis for the other standards mentioned above. 
 
There are currently two versions of the program - SimpleTerm Standard Edition (SE) and Gold 
Edition (GE). The two versions have a slightly different feature set and are priced differently so 
that you only pay for what you need.  
 
This user guide explains features available on SimpleTerm Standard only, please refer to the 
SimpleTerm Gold User Guide if you are using SimpleTerm Gold. 

2.1 Features List 

A brief list of some of the features included in SimpleTerm are given below: 
 

• Colour coded ASCII/hexadecimal “mixed mode” data view. 
• Baud 110 to 115200. 
• Supports COM1 to COM256. 
• Import and Export SimpleTerm Profiles. 
• Streaming data input. 
• Designed for Microsoft® Windows 9x, 2000, XP, Vista & Windows 7 (32 & 64 Bit). 
• Data entry using the PC keyboard – similar to a terminal emulator.  
• RS232 control signal monitoring using “Virtual LEDs” - breakout box style. 
• Capture to file and send data from files. 
• Colour print capability. 
• Online changing of line settings and display font. 
• Copy & paste data to other applications in RTF (Rich Text Format) 
• Built in search. 
• Integrated feature rich notepad. 
• Supports “Virtual COM” ports (e.g. as presented by USB-Serial adaptors). 
• High performance, fast display screen. 
• Radix/Notation Converter. 

2.2 System Requirements 

Operating system:  Microsoft® Windows 95/98/ME/2000/XP/Vista/Windows 7 (32 & 64 Bit) 
Hardware requirements:  Pentium processor or equivalent, 166 MHz or faster, minimum 32 MB 
RAM and one or more available COM ports. Note that additional cables may be required for 
connecting any equipment to be tested. SVGA monitor and graphics card capable of 256 colours 
and 800x600 pixel resolution. 
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String Entry Pane 
Communication Window / Screen 

Control Signal Panel 

Status Bar 

Toolbar 

2.3 User Interface 

A screenshot of the application is shown below in Figure 1. 
 
Figure 1: SimpleTerm – Running in Windows® XP. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The user interface of SimpleTerm is divided into six main sections – a brief description of each is 
given here: 
 
Toolbar   
Most common functions may be selected from the toolbar by clicking on the icons. Placing the 
mouse cursor over each icon will display a ‘hint’ window indicating its function. 
 
Quick Configuration Panel 
This may be used to rapidly configure the serial port line settings. With the exception of the Port 
(COM port) setting the line settings may be changed while online/connected. 
 
String Entry Pane 
This is used to quickly type in a sequence of data (sometimes referred to as a string) for 
transmitting via the COM port. The data can contain normal ASCII data or special/extended 
characters using an escape character to define characters in hexadecimal. 
 
Communication Window / Screen 
This is the input/output display screen. It displays the out going and incoming communication 
from the serial port. The font used for displaying the data is changeable. The communication 
window may also be referred to generally as the screen. 
 
Control Signal Panel 
This panel contains “Virtual LEDs” to display the state of the RS232 control lines. The LEDs for 
the output handshaking lines from the PCs serial port (DTR and RTS) are “clickable” using the 
mouse and therefore may be used as switches to toggle the state of these lines manually. 
 
Status Bar 
Additional information about the communication status, errors, input/output byte count, screen 
selection or the current settings may be shown in the status bar. 
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3 Features and Usage 

SimpleTerm displays all incoming serial port data and all outgoing serial port data sent via the 
keyboard or sent using the “String Entry Pane” in its communication window. Incoming and 
outgoing data are displayed using different colours. SimpleTerm has scroll functionality that 
allows the viewing of received data that has scrolled off the screen. The logged data on 
SimpleTerms communication window may be copied to the clipboard or printed. 
 
SimpleTerm processes serial data streams containing any ASCII characters from 0 – 255 
decimal (when operating in 8-bit mode). 
 
Note that keys typed within the communication window may be sent directly to the serial port. 
Alternatively any character from 0 - 255 decimal may be inserted into SimpleTerm’s 
communication window (for transmission) using the “Alt + key” sequence. Hold down the "Alt 
Key" on your keyboard and press the numbers (0 followed by the 3-digit ASCII value in decimal) 
for the character you want on your numeric keypad. For example, “Alt + 0065” will result in the 
ASCII character ‘A’ being inserted into the communication window. 

3.1 Data Formatting and Colour Code 

SimpleTerm handles all the serial port data in an 8 bit-oriented way. Every sequence of serial 
data consists of one or more 8 bit characters. 
 
The data is displayed on screen in a colour coded ASCII/hexadecimal “mixed mode” view. 
Incoming and outgoing data are displayed using different colours as described here. 
 

 
 
 
Output data: 

• Standard “printable” ASCII characters are shown on-screen in black. 
• Special/extended characters (00h to 31h and 7Fh to FFh) characters are shown  

on-screen in blue  and are enveloped in left and right angle brackets e.g. <hh> where 
hh are the two hexadecimal digits of the 8-bit character. 

 
Input data: 

• Standard “printable” ASCII characters are shown on-screen in green. 
• Special/extended characters (00h to 31h and 7Fh to FFh) characters are shown  

on-screen in red  and are enveloped in left and right angle brackets e.g. <hh> where 
hh are the two hexadecimal digits of the 8-bit character. 

 
Here is an example of the data formatting and colour coding used for outgoing data: 
 
OUTPUT<0D> 
 
For the above example, standard ASCII characters “OUTPUT” were typed in using the 
keyboard. After this the ENTER key was pressed resulting in the display of a “special” character 
in hexadecimal enveloped in “<>”. 
Here is an example of the data formatting and colour coding used for incoming data: 
 
INPUT<0D> 
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For the above example, standard ASCII characters “INPUT” followed by a CR (CARRIAGE 
RETURN) character of value 0D hex were received at the opened COM port. 

3.2 Com Port Initialisation and Connection 

The words “open”, “connected” and “online” may be used thought this document to refer to the 
state of a COM port as being selected, initialised and “open” for communication. 
 
Line Settings 
All common line settings are configurable via the “Quick Configuration Panel”. SimpleTerm 
supports standard baud rates from 110 to 115200 which are configurable while online. Data bits, 
parity and stop bits are also configurable online. Standard COM port numbers and “Virtual COM” 
ports 1 to 256 are supported on SimpleTerm SE. “Virtual COM” ports may be presented by 
devices such as USB to Serial adaptors and Bluetooth Serial Port Profile devices. 
 

 
 
Connect / Disconnect 
You can open a COM port for communication by clicking on the Connect / Disconnect icon in the 
“Toolbar” or alternatively by selecting the menu item “Comms->Connect”: 

 
 
The COM port number and its settings are as displayed in the “Quick Configuration Panel”. Note 
that the hardware control signals RTS and DTR are always asserted on connection to enable 
reception of data. 
  
Note that certain functions and menu items are disabled until a valid COM port has been opened 
for communication.  
 
After the COM port is opened, the Connect / Disconnect icon in the “Toolbar” changes its image 
to that shown below. This image depicts a cable connection to a serial port and signifies the 
state of the COM port as open for communication. Clicking on this icon will toggle the connection 
state back again so that the COM port is closed. 

 
 
Note that after the COM port has been opened the ”Comms->Connect” menu item is disabled 
and the ”Comms->Disconnect” menu item becomes enabled for selection. 
 
CAUTION: it is good practice and more importantly to avoid system instability, to always 
disconnect (if connected) before physically removing devices which present a Virtual COM port 
to your PC/Laptop. These may be USB-Serial adaptors for example for which the emulated 
COM port disappears on physically removing the device. 

3.3 Data transmission from file / Capture to file 

Send file (binary)… 
This function assumes that the COM port has been initialised for 8-bit communications, that is, 
make sure that the “Data bits” in the “Quick Configuration Panel” is set to 8. 
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Click on the menu item “Transfer->Send file (binary)… ” and select the file to transmit via the 
serial port. All data within the file is sent through the port and a progress bar is used to show the 
progress of the transfer and the status bar shows any additional information -including the file 
size and percentage of transfer completed. The menu item will change during the transfer of a 
file to “Transfer->Stop Sending”. This will allow the data transfer to be stopped or cancelled. 
Alternatively, hitting the End key on the keyboard may also be used to cancel / stop data 
transfers. 
 

 
 
Capture to File (Binary)… 
SimpleTerm can capture/save outgoing & incoming serial data into a file. 
 
This function assumes that the COM port has been initialised for 8-bit communications, that is, 
make sure that the “Data bits” in the “Quick Configuration Panel” is set to 8. 
 
Click on the menu item “Transfer->Capture to file (binary)…” and enter the location and filename 
of the file to save incoming serial data to. 
 
The menu item will change during capture to “Transfer->Stop Capture” so that the data logging 
may be stopped. Alternatively, hitting the End key on the keyboard may also be used to cancel / 
stop data capture. 
 
The following data is logged:  
 
Any incoming serial data stream containing 8-bit characters will be logged.  
All outgoing serial data containing 8-bit characters will be logged except data from files sent 
using the “Transfer->Send File (Binary)…” menu item. 

3.4 Control Signal Panel 

This panel contains “Virtual LEDs” to display the state of  the RS232 control lines when 
connected/online. The LEDs turn bright green when the RS232 control lines are asserted. 
 

 
 
The right hand side of the panel monitors the PCs serial port input signals CTS, DSR, RI and 
DCD. The panel also contains an indicator which flashes briefly (bright green) when a “break” 
condition is detected on the serial communications line. 
 
The left hand side of the panel contains the output handshaking lines DTR and RTS which are 
controlled manually. These signal lines are asserted by default (LEDs bright green) but can be 
switched off by clicking on the respective LEDs using the mouse or using function key keyboard 
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shortcuts F7 and F8 respectively. Similarly a break condition may be set by clicking on the LED 
labelled “BRK” or using the keyboard shortcut F9. 

3.5 String Entry Pane 

This is used to quickly type in a sequence of data for transmitting via the COM port. Insert data 
for transmission in ASCII or in hexadecimal using the escape character ‘\’ in the form ‘\hh’ where 
hh are two hexadecimal digits. 
 

 
 
Click on the Send button on the right hand side (or press the Insert key) to actually send the data 
to the serial port. The data can be sent repeatedly by setting the “repeat send counter” field (to 
the left of the Send button) to a value greater than zero. If set to zero then the data will be sent 
continuously until the Stop button is pressed (or the End key is hit). 
 
Escape Sequences 
 
Note that the following escape sequences for inserting characters are valid (values in 
hexadecimal): 
 
\hh   Any 8-bit character in hex notation where hh are two hex       

digits (in either uppercase or lowercase). 
\b  08 hex (Backspace) 
\n   0a hex (Line feed) 
\r   0d hex (Carriage Return) 
\t   09 hex (Horizontal Tab) 
\\   5c hex (Backslash) 
 
For example to send "TEST", Carriage Return and a Line Feed character then try: 
TEST\0D\n 
 
Keyboard Shortcuts  
 
Insert – send data. 
End – stop sending data. 

3.6 Find 

The “Find” dialog box is displayed when the menu item “Edit->Find…” is clicked or alternatively 
click on the tool bar icon (shown top left here): 
 

 
 
You may search for specific words or characters displayed in the communication window. Place 
the cursor on the communication window to select the start position to search from. On the “Edit” 
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menu, click “Find”. In “Find what”, type the characters or words you want to find, and then click 
Find Next. To find additional instances of the same text, continue to click Find Next. 

3.7 Data Exporting and Printing 

Copy to Clipboard 
SimpleTerm can copy serial data to the clipboard which can then be pasted into other 
applications such as word processors in colour if the RTF (Rich Text Format) is supported or as 
plain text into most text editors. 
 
First select the area of data to copy. Then use the menu item “Edit->Copy to Clipboard” to copy 
the text to the clipboard or alternatively, “right-click” on the communication window and select 
“Copy to Clipboard” from the pop-up (context) menu. 
 
The data can be pasted as plain text in a suitable text editor such as notepad or as RTF text in 
applications like Microsoft® Wordpad. 
 
Colour Printing 
The on-screen data can be printed off in colour. Use the menu item “File->Print Setup…” to 
setup the printer and page settings then use  “File->Print” to print. 

3.8 New Session / Clear Screen  

The communication window’s contents may be cleared using the menu item “Edit->New 
Session”. This also resets any screen, error message or character information on the status bar 
(such as the byte count). Only the running timer in the status bar (indicating the duration the 
COM port has been opened for) is not reset. 
 
To just clear the communication window of data then use the menu item “Edit->Clear Screen” or 
click on the tool bar icon shown here: 

 

3.9 ASCII table 

An ASCII Table is provided for reference under the menu item“ Help->ASCII Table...”. ASCII 
characters 00-7F hexadecimal are displayed in various notations including decimal, hexadecimal 
and binary. The text within this window may be selected and copied to the clipboard. 
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3.10 Settings Window 

This settings window is shown when the menu item “Settings->Display…” is clicked or  
alternatively click on the following tool bar icon: 
 

 
 
This window is split into three tab separated sections for configuring the applications behaviour  
and display options.  
 

 
 
The three buttons at the bottom of the Settings Window allow any changes to the configuration 
to be applied temporarily (“OK” button), saved permanently to the configuration settings *.ini file 
(“Save Settings” button) or discarded (“Cancel” button). 
 
Display Settings 
 
The first tab section (Display Settings) contains various settings to configure the display options 
of the communication window:  
 
Display Mode & Font 
The data viewing options for the communication window are available here via a drop down list. 
The selections of viewing modes include “ASCII/Text”, “Mixed (ASCII, hexadecimal)” and 
“Hexadecimal” modes. 
 
The font used to display data on the communication window may be changed by clicking on the 
button labelled “A” under the label “Font”. 
 
Lines / Columns 
The communication window displays data on a matrix of lines and columns. 
 
“Adjust Columns To Screen Width” - the column width will be automatically adjusted as the 
application screen width is adjusted if this item is ticked. Leave un-ticked to enable the column 
width to be set manually. 
 
Filters and Conversion 
“Show input only” – if this item is ticked then only incoming data from the opened COM port is 
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displayed on the communication window. 
 
“New line on CR” – if this item is ticked then a new line is inserted into the communication 
window after a CARRIAGE RETURN character (0D hex) has been received. 
 
“New line on LF” – if this item is ticked then a new line is inserted into the communication 
window after a LINE FEED character (0A hex) has been received. 
 
”TAB to spaces (“ASCII/Text” mode only)” – TAB (09 hexadecimal) characters are replaced with 
space (20 hexadecimal) characters for correct display and alignment when running in ASCII 
(display) mode. Insert an integer between 1 and 40 for the number of spaces per TAB. 
 
Error Checking  
 
The second section “Error Checking” contains an Option to enable the checking of 
communication errors including parity errors.  
 
This option is dependent on the support of error checking within the COM port drivers installed 
for your serial port hardware e.g. some early (non-compliant) device drivers for USB to Serial  
adaptors did not support parity error checking. 
 

 
 
General 
 
The third section “General” contains other miscellaneous options:  
 
“Automatically connect on startup” - if this item is ticked then on startup, SimpleTerm  
will attempt to automatically open the COM port (preset in the saved configuration settings). 
 
“Automatically connect on keypress” - if this item is ticked then SimpleTerm will attempt to 
automatically open the COM port (preset in the saved configuration settings) when a key has 
been pressed within the communication window. 
 
“Display String Entry Pane” – if this item is ticked then the String Entry Pane is visible 
otherwise it is hidden. 
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3.11 Import and Export SimpleTerm Profiles 

For rapid configuration when working with different devices or  
applications which require different configuration settings, SimpleTerm supports the saving of all 
configuration information in named text files (with extension .stp) known as Profiles. Instead of 
reconfiguring all the settings every time a different RS232 / COM port device is used, simply 
import (a previously exported) SimpleTerm Profile. 
 
Note that SimpleTerm SE will still automatically load the default settings (within its  
ST.ini configuration file) when it starts. 
 
Export as a Profile 
Allows saving of the current SimpleTerm configuration as a Profile so that the configuration may 
be recalled in future by importing the Profile. 
 
Generally export a Profile for each new device so all the information does not have to be in 
entered again in the future. 
 
To export a Profile:  

1) Adjust all SimpleTerm settings appropriate for the device or application used. Insert any 
data for saving within the String Entry pane. 

 
2) Click the menu item “Settings->Export as a Profile” and type the name of the Profile 

using the displayed “Save As” dialog box. 
 
Import Profile 
Reconfigures SimpleTerm by loading the configuration settings from a Profile (of file extension 
.stp). This option also clears the communication window after re-configuration by starting a new 
communication session. 
 
To import a Profile, click the menu item “Settings->Import from Profile” and select a file using the 
displayed “Open” dialog box. 

3.12 Status Bar and Byte Selection Information 

The status bar is a horizontal area at the bottom of the communication window  
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in SimpleTerm for providing additional user feedback and information about the communication 
status, errors, input / output byte count and screen selection. 
 
The bar is split into to 5 sections and each section is described here in visual order from left to 
right: 
 
Section 1 displays a running timer indicating the duration for which the COM port has been in a 
connected state. 
 
Section 2 displays the line and column number (abbreviated to “Ln:” and “Col:” respectively) of 
the last character in a selection made in the communication window’s display matrix. Also 
displayed is the number of selected display characters on screen (abbreviated to “Sel:”). 
  
Section 3 displays the number of bytes recorded as having been sent (“Bytes Out:”) or received 
(“In:”) through the open COM port. A total of outgoing and incoming bytes is also displayed 
(“Total:”) . Note that to reset the byte count (and also clear the screen) use the menu item “File-
>New Session”. 
 

 
 
Section 4 displays a selected byte within the communication window in binary, decimal and 
hexadecimal notations. The selection must be for a single byte of data. To select a byte that is 
already displayed on screen in hexadecimal, both characters within the “<>” envelope must be 
selected as shown above. 
 
Section 5 may be used to display miscellaneous text for user feedback or to indicate 
communication errors. 

3.13 User Notes 

The User Notes is a simple, yet feature rich single page notepad for storing handy notes or data 
during a debugging session for example. The “User Notes” screen is displayed when the menu 
item “View->User Notes” is clicked or alternatively click on the following tool bar icon: 
 

 
 
The notepad supports different font colour and style selections within the page and provides a lot 
of editing functionality similar to the Microsoft WordPad application. In addition, hyperlinks to 
internet web sites and pages, email addresses or to files and folders on your computer may be 
stored. 
 
To save changes made in the User Notes screen press the “Save” button. When 
 the notes are saved, the data is stored in a RTF (Rich Text Format) file called notes.rtf within 
Simpleterm’s main directory. This file is importable into other applications that support RTF files 
including Microsoft WordPad and Word if required. 
 
To close the User Notes screen press the “Close” button. 
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User Notes - Toolbar and Pop-up Menu 
Toolbar icons from left to right and pop-up (context) menus are described here: 
 
Copy - copies text so you can paste it in another location by selecting the text and then 
clicking the Copy icon or alternatively “right-click” using the mouse and select “Copy” from the 
pop-up menu. 
 
Cut - cuts text so you can move it to another location by selecting the text and then clicking the 
Cut icon or alternatively select “Cut” from the pop-up menu. 
 
Paste – inserts text you have cut or copied by clicking in the document where you want to insert 
the text and then clicking the Paste icon or alternatively select “Paste” from the pop-up menu. 
 
Find – use to search for words or characters in your User Notes document by clicking the Find 
icon. To find additional instances of the same text, continue to click Find Next. 
 
Font Selector - changes a font type, style, size and colour by selecting the text that you want to 
change and then clicking the “Font Selector” icon to display the font options. 
 
Select All (Pop-up menu only) – selects all the text within the document. 
 
Clear All (Pop-up menu only) – clears the notes screen for a blank document. 
 
Paste In String Entry Pane (Pop-up menu only) – places selected text into the “String Entry 
Pane” ready for sending to the serial port. 
 
There are also icons/buttons (at the top right of the User Notes screen) for quick changes to the 
font and style of selected text. These include a drop down list of available system fonts and a 
“B”, “I” and “U” button for changing the style of selected text to bold, italic or underlined 
respectively. 
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User Notes - Editing Keyboard Shortcuts  
 
Key Strokes   Shortcut to 
CTRL+A   Select all text 
CTRL+C   Copy 
CTRL+X                  Cut 
CTRL+V           Paste 
 
CTRL+F   Font selector 
CTRL+B   Bold 
CTRL+I   Italics 
CTRL+U   Underline 
 
Increment Font Size CTRL+} 
Decrement Font Size CTRL+{ 
 
CTRL+S or ALT+S    Save Changes 
CTRL+Z    Undo (multiple undo support) 
CTRL+Y    Redo (multiple redo support) 
ALT+C          Close (User Notes screen) 
F3             Find 
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3.14 Notation Converter 

This dialog box is shown when the menu item “View->Notation Converter” is clicked. Use this to  
convert data to and from decimal / hexadecimal notation. Conversion of binary to decimal and  
hexadecimal is also possible. 
 

 
 
The following example shows how to use this dialog box to view three different number  
representations (hex, decimal and binary) of hexadecimal F0: 
 
1) Type F0 in the Hex field. Notice that “240” is displayed in the Dec field and “1111 0000” is 
displayed in the Bin field. 
 
2) Similarly, (delete the current text) and type 240 in the Dec field. Notice that F0 will be 
displayed in the Hex field and “1111 0000” is displayed in the Bin field. 
 
3) Click the Close button to close the Notation Converter dialog box. 
 
Note:  

a) The label “(MSB)” indicates that the most significant bit in the binary representation is 
the leftmost bit within the “Bin:” field. 

b) The “Bin Digits” label indicates the number of binary bits entered/displayed in the “Bin:” 
field. 

4 Reference: Menu, Toolbar and Keyboard Shortcuts 

Most menu items have an ALT+key combination keyboard shortcut to select items within the 
menu. For example, to the menu item “File->New Session”, hold down the ALT key and then 
press the ‘f’ key for the file menu. Then press the ‘n’ key for New session. Other menu items 
have a Function key (F2-F10) associated and these are shown below. 

4.1 File Menu 

 
 
New Session 
Clears the display screen and resets the byte count in the status bar. 
 
Print / Print Setup...  
Setup the printer and print the contents of the communication window. 
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Exit 
Exit the SimpleTerm application. Keyboard shortcut: F10. 

4.2 Edit Menu  

 
 
Copy to Clipboard 
To copy the text in the communication to the clipboard so that you can paste it in another 
application, select the text, and then on the “Edit” menu, click “Copy to Clipboard”. 
  
Find…  
Search for words or characters in the communication window. Keyboard shortcut: F3. 
 
Select All 
You can select all text/characters in the communication window at once by clicking “Edit”, and 
then clicking “Select All”. 
 
Clear Screen 
Clear the contents of the communications window. Note that this does not affect the byte count 
in the status bar (see File Menu->New Session). Keyboard shortcut: F4. 
 
Clear Status Bar Messages 
Clears any notification or error messages in the status bar. 

4.3 View Menu 

 
 
Display Mode 
This expanding menu item allows selection of the data viewing options for the Communication 
Window. A sub-menu allows the selection between “ASCII/Text”, “Mixed (ASCII, hexadecimal)” 
and “Hexadecimal” modes. 
Set Font…  
Set the font used for displaying data in the communication window. 
 
String Entry Pane 
Toggle the display of the Quick Entry Pane.  
 
Notation Converter 
Toggle the display of the Notation Conversion window. 
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User Notes 
Show the User Notes window. Keyboard shortcut: F6. 
 
Full Screen / Exit Full Screen 
Full Screen option maximises the SimpleTerm application window so it covers the full screen. 
Exit Full Screen option (shown when window is already maximised) restore the window to its 
previous size. Keyboard shortcut: ALT+ENTER (toggle action). 

4.4 Settings 

 
 
 
Display… 
Show the Settings window for selecting the application program options  
(e.g. for display and other communication settings). Keyboard shortcut: 
F5. 
 
Save 
Save application settings (which include the serial port line settings) to a file called STGold.ini in 
the current directory. 
 
Import from Profile 
Reconfigure SimpleTerm by loading the configuration settings from a Profile (file extension .stp).  
 
Export as a Profile 
Save the current SimpleTerm configuration as a Profile so that the configuration may be recalled 
in future by importing the Profile. 
 

4.5 Comms 

Connect 
Open the communication port selected in the Quick Configuration Panel and enable serial data 
transfer. Keyboard shortcut: F2 (toggle action). 
 
Disconnect 
Close the communication port selected in the Quick Configuration Panel and enable serial data 
transfer. Keyboard shortcut: F2 (toggle action). 

4.6 Transfer 

 
 
Send File (Binary)… 
Send binary data within a file through the serial port (when 
connected). 
 
Capture To File (Binary)… 
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Capture/save incoming serial data into a file (when connected). 
 
Send Ctrl Char (00…0F hex) 
Transmit a control char within the range 00 and 0F hex to the serial port (when connected). 
 
Send Ctrl Char (10…1F hex) 
Transmit a control char within the range 10 an d 1F hex to the serial port (when connected). 

4.7 Help 

 
 
About SimpleTerm… 
Display information about your SimpleTerm application including version  
number and copyright information. 
 
ASCII Table… 
Displays the ASCII Table window. 

4.8 Toolbar 

 
 
Icons from left to right: 
 
Connect / Disconnect 
Open / close the communication port. Keyboard shortcut: F2 (toggle action). 
 
Find 
Search for words or characters in the communication window. Keyboard shortcut: F3. 
 
Clear Screen 
Clear the contents of the communications window. Keyboard shortcut: F4. 
 
Show Settings Window  
Show the Settings window. Keyboard shortcut: F5. 
 
User Notes 
Show the User Notes window. Keyboard shortcut: F6. 
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Appendix A – ASCII Chart 

ASCII, the American Standard Code for Information Interchange, was developed in the 1960's as a 
standard 7-bit code for identifying letters, numbers, symbols, and special characters in the English 
language. It was later expanded (as Extended ASCII) to include additional symbols and foreign language 
characters. Standard ASCII consists of 128 characters, ranging from 0 to 127 which can be broken down 
into the following subgroups: 
 
0 to 31, 127: Control codes (includes null, backspace, line feed and others)  
32 to 47, 58 to 64, 81 to 86, 123 to 126: Punctuation marks, mathematical (and other) symbols 
48 to 57: Numbers 0 through 9   
65 to 80: Capital letters A through Z 
87 to 122: Lower case letters a through z 
 
Standard ASCII Chart 
 
The standard chart includes the ASCII character or control and their related decimal and hexadecimal 
values. Also shown are the control key sequences for the control codes. Note, to obtain codes 0 to 31, 
console Control Key is pressed while simultaneously pressing a Letter Key, e.g. ^J is the line feed 
character. Control Key subtracts decimal 64 (40h) from Letter Key pressed. 
 
 

 
Legend: ^Key - Control Key + Letter Key combination except 30 (1E hex) = Control +caret. 

Dec Hex ^Key ASCII Dec Hex ASCII Dec Hex ASCII Dec Hex ASCII 

0 0 ^@ NUL (Null)   32 20 (Space) 64 40 @ 96 60 ` 

1 1 ^A SOH (Start of Heading) 33 21 ! 65 41 A 97 61 a 

2 2 ^B STX (Start of Text) 34 22 " 66 42 B 98 62 b 

3 3 ^C ETX (End of Text) 35 23 # 67 43 C 99 63 c 

4 4 ^D EOT (End of Transmission) 36 24 $ 68 44 D 100  64 d 

5 5 ^E ENQ (Enquiry) 37 25 % 69 45 E 101  65 e 

6 6 ^F ACK (Acknowledgement) 38 26 & 70 46 F 102  66 f 

7 7 ^G BEL (Bell) 39 27 ' 71 47 G 103  67 g 

8 8 ^H BS  (Backspace) 40 28 ( 72 48 H 104  68 h 

9 9 ^I HT  (Horizontal Tab) 41 29 ) 73 49 I 105  69 i 

10 A ^J LF  (Line Feed) 42 2A * 74 4A J 106  6A j 

11 B ^K VT  (Vertical Tab) 43 2B + 75 4B K 107  6B k 

12 C ^L FF  (Form Feed) 44 2C , 76 4C L 108  6C l 

13 D ^M CR  (Carriage Return) 45 2D - 77 4D M 109  6D m 

14 E ^N SO  (Shift Out) 46 2E . 78 4E N 110  6E n 

15 F ^O SI  (Shift In 47 2F / 79 4F O 111  6F o 

16 10 ^P DLE (Data Line Escape) 48 30 0 80 50 P 112  70 p 

17 11 ^Q DC1 (Device Control 1) 49 31 1 81 51 Q 113  71 q 

18 12 ^R DC2 (Device Control 2) 50 32 2 82 52 R 114  72 r 

19 13 ^S DC3 (Device Control 3) 51 33 3 83 53 S 115  73 s 

20 14 ^T DC4 (Device Control 4) 52 34 4 84 54 T 116  74 t 

21 15 ^U NAK (Negative Ack.) 53 35 5 85 55 U 117  75 u 

22 16 ^V SYN (Synchronous Idle) 54 36 6 86 56 V 118  76 v 

23 17 ^W ETB (End of Transmit Block)  55 37 7 87 57 W 119  77 w 

24 18 ^X CAN (Cancel) 56 38 8 88 58 X 120  78 x 

25 19 ^Y EM  (End of Medium) 57 39 9 89 59 Y 121  79 y 

26 1A ^Z SUB (Substitute) 58 3A : 90 5A Z 122  7A z 

27 1B ^[ ESC (Escape) 59 3B ; 91 5B [ 123  7B { 

28 1C ^\ FS  (File Separator) 60 3C < 92 5C \ 124  7C | 

29 1D ^] GS  (Group Separator) 61 3D = 93 5D ] 125  7D } 

30 1E ^^ RS  (Record Separator) 62 3E > 94 5E ^ 126  7E ~ 

31 1F ^_ US  (Unit Separator)  

  

63 3F ? 

  

95 5F _ 

  

127  7F (Delete)  
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Appendix B – Radix Conversion Charts 

Converting Hexadecimal to Decimal 
This chart shows the conversion between hex and decimal. 
 
    0   1   2   3   4   5   6   7   8   9   A   B   C   D   E   F 
0  000 001 002 003 004 005 006 007 008 009 010 011 012  013 014 015  
1  016 017 018 019 020 021 022 023 024 025 026 027 028  029 030 031  
2  032 033 034 035 036 037 038 039 040 041 042 043 044  045 046 047  
3  048 049 050 051 052 053 054 055 056 057 058 059 060  061 062 063  
4  064 065 066 067 068 069 070 071 072 073 074 075 076  077 078 079  
5  080 081 082 083 084 085 086 087 088 089 090 091 092  093 094 095  
6  096 097 098 099 100 101 102 103 104 105 106 107 108  109 110 111  
7  112 113 114 115 116 117 118 119 120 121 122 123 124  125 126 127  
8  128 129 130 131 132 133 134 135 136 137 138 139 140  141 142 143  
9  144 145 146 147 148 149 150 151 152 153 154 155 156  157 158 159  
A  160 161 162 163 164 165 166 167 168 169 170 171 172  173 174 175  
B  176 177 178 179 180 181 182 183 184 185 186 187 188  189 190 191  
C  192 193 194 195 196 197 198 199 200 201 202 203 204  205 206 207  
D  208 209 210 211 212 213 214 215 216 217 218 219 220  221 222 223  
E  224 225 226 227 228 229 230 231 232 233 234 235 236  237 238 239  
F  240 241 242 243 244 245 246 247 248 249 250 251 252  253 254 255  
 
Usage example: 
Hex 31 is equivalent to decimal 49. Alternatively decimal 255 is equivalent to hex FF. 
 
Converting Hexadecimal to Octal 
This chart shows the conversion between hex and octal 
 
    0   1   2   3   4   5   6   7   8   9   A   B   C   D   E   F  
0  000 001 002 003 004 005 006 007 010 011 012 013 014  015 016 017  
1  020 021 022 023 024 025 026 027 030 031 032 033 034  035 036 037  
2  040 041 042 043 044 045 046 047 050 051 052 053 054  055 056 057  
3  060 061 062 063 064 065 066 067 070 071 072 073 074  075 076 077  
4  100 101 102 103 104 105 106 107 110 111 112 113 114  115 116 117  
5  120 121 122 123 134 125 126 127 130 131 132 133 134  135 136 137  
6  140 141 142 143 144 145 146 147 150 151 152 153 154  155 156 157  
7  160 161 162 163 164 165 166 167 170 171 172 173 174  175 176 177  
8  200 201 202 203 204 205 206 207 210 211 212 213 214  215 216 217  
9  220 221 222 223 224 225 226 227 230 231 232 233 234  235 236 237  
A  240 241 242 243 244 245 246 247 250 251 252 253 254  255 256 257  
B  260 261 262 263 264 265 266 267 270 271 272 273 274  275 276 277  
C  300 301 302 303 304 305 306 307 310 311 312 313 314  315 316 317  
D  320 321 322 323 324 325 326 327 330 331 332 333 334  335 336 337  
E  340 341 342 343 344 345 346 347 350 351 352 353 354  355 356 357  
F  360 361 362 363 364 365 366 367 370 371 372 373 374  375 376 377  
 
Usage example: 
Hex 7F is equivalent to octal 367. Alternatively octal 377 is equivalent to Hex FF. 
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Appendix C – Pinout and Signals for the PC RS232 Co nnector 

DB9 RS232 Port (IBM PC XT/AT) 
 
 
                           DB9 pin D-SUB male 
 
 
Pin Signal Name   Direction (DTE ← DCE) 
1 CD (Carrier Detect)  ← 
2 RXD (Receive Data)  ← 
3 TXD (Transmit Data)  → 
4 DTR (Data Terminal Ready) → 
5 GND (System Ground)   - 
6 DSR (Data Set Ready)  ← 
7 RTS (Request to Send)  → 
8 CTS (Clear to Send)  ← 
9 RI (Ring Indicator)  ← 
 
Note: a) Signal names are with respect to the computer/PC. b) Direction is from 
peripheral/modem (DCE) to the computer (DTE) e.g. RXD is the computer’s input pin. 
 
DB25 RS232 Port 
 
 
                                                 DB25 pin D-SUB male 
 
 
Pin Signal Name      Direction (DTE ← DCE) 
1 SHIELD (Shield/Protective Ground)    - 
2 TXD (Transmit Data)      → 
3 RXD (Receive Data)     ←       
4 RTS (Request to Send)     →    
5 CTS (Clear to Send)     ←        
6 DSR (Data Set Ready)     ←       
7 GND (System Ground)            - 
8 CD (Carrier Detect)     ←        
9 n/c        -                      
10 n/c        -                      
11 n/c        -                      
12 n/c        -                      
13 n/c        -                      
14 n/c        -                      
15 n/c        -                      
16 n/c        -                      
17 n/c        -                      
18 n/c        -                      
19 n/c        -                      
20 DTR (Data Terminal Ready)     → 
21 n/c        -                                           
22 RI (Ring Indicator)     ←         
23 n/c        -                                           
24 n/c        -                                           
25 n/c        -                                     
 
Note: a) Signal names are with respect to the computer/PC. b) Direction is from 
peripheral/modem (DCE) to the computer (DTE) e.g. RXD is the computer’s input pin. 
c) Do not connect SHIELD(1) to GND(7). 
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DB9-F (DEVICE B) DB9-M (DEVICE A) 
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Pin 1 
 
Pin 2 
 
Pin 3 
 
Pin 4 
 
Pin 5 
 
Pin 6 
 
Pin 7 
 
Pin 8 
 
Pin 9 

D1, D2 (1N4148) 
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Appendix D – SimpleTerm Half Duplex Monitoring Cabl e 

SimpleTerm may be used as a low cost half duplex RS232 data monitor with the addition of 
some minimal external hardware. Two devices that take turns sending data are said to be 
communicating in "half duplex" mode. See Figure C1 below for the pass through hardware 
required. 
  
With this straightforward pass through arrangement, DEVICE A will still communicate with 
DEVICE B and vice versa but the communication (if half-duplex) may be monitored via a 
connection to the PCs serial port. 
 
 
Figure C1:  Half Duplex Monitoring Adaptor / Cable 
 


